WinBraille 5.0

WinBraille 5 is a braille editor developed by
Index Braille.
This manual includes:
Getting started instructions
Program overview
How to setup and work in WinBraille
Samples and ideas
WinBraille 5 supports:
- Index Embosser V3, Basic-D, Basic-S,
Everest, 4X4 PRO and 4Waves PRO
- MS XP and Vista
- MS Office 2003 and 2007
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Welcome to WinBraille

1.1

General

1.1.1

System requirements
Operating systems: Microsoft Windows XP and Vista.
Office packages: Office 2003 and 2007.
Embossers: Index Braille V3, Basic-D, Everest, 4X4 PRO and 4Waves PRO.
Supported document types:
Microsoft Word Office 2003
Microsoft Word Office 2007
Adobe Portable Document
Temporary
Text
WinBraille Document
WinBraille Template
WinBraille Command
WinBraille4 Project
Index Braille License
Duxbury Braille
Duxbury Braille

1.1.2

*.doc
*.docx
*.pdf
*.tmp
*.txt
*.wbrl
*.wbrt
*.wcf
*.wif
*.iblf
*.dxb
*.brf

User rights
Windows:
Log in with "Administrator" rights when installing WinBraille and Index Printer drivers.
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WinBraille overview
This chapter gives an introduction to WinBraille, showing you the menus and where to find specific tools.

2.1

Free/PRO
WinBraille 5 Free
Download and upgrade for free.
WinBraille Free handles most document types like office, pdf, and e-mails.
· Vista and XP support
· Supports Duxbury files
· Headers and footers
· Office 2003 and 2007 support
WinBraille 5 PRO
Free 60 day trial
Free program update
WinBraille PRO supports most document types and has many advanced features, including structured
documents and much more;
· Hyphenation
· Automatic Table of Contents
· Braille Mathematics using MS Equation Editor
· Tables
· Adjustable line spacing
· Bullet lists
· Selectable menus
· User defined shortcuts

2.1.1

Upgrade to PRO
To upgrade from WinBraille Free to PRO:
1. In the file menu, choose Options...
2. Choose General.
3. Select PRO in the drop down menu "WinBraille mode"
4. Go to the Menus tab and press "Check All" which enables all menu options.
5. Save the settings.
WinBraille PRO is free of charge for 60 days.

2.1.2

Purchase a licence key
The price for a single licence for WinBraille PRO is presented at Index web www.indexbraille.com.
Ordering process
1. Send your order to your local Index distributor. If there is no local distributor available send an order mail
to order@indexbraille.com.
2. A licence key will be mailed to you within five working day after your order is confirmed.
The price include free unlimited upgrade.
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The licence key is restricted to be used on one computer. The licence system used by Index Braille require
internet access. If the communication is manipulated or blocked the licence will not be valid and the
WinBraille change into Free mode.
If one licence is used on multiple computers Index Braille database will discover this mis-use of the licence
and have will treat this licence number as manipulated. Consequently all WinBraille applications using this
licence number will be turned into WinBraille Free mode.

2.1.3

Install your licence key
Licence file
The licence file name is WinBraille_#####-XX.iblf
Where #### is the licence order number and XX is the number of licences included in this file.
Where to save it?
To make it easy to find, Index Braille recommends to save the licence file at your desktop and in your
backup system.
Install the licence
Install it by double clicking on the licence key.
WinBraille 5 starts up and register the licence key at your computer.
If your WinBraille licence is a multiple user. Please install the same file on the number of computers you
have licence for.
Get licence number
The licence number is a part of the WinBraille licence file name. Example WinBraille_30586-10 where
30586 is the order number and 10 is the number of licences included in this file.
In WinBraille menu
Go to Help/ About to get complete information about your WinBraille installation including Licence
Number, Number of Licences etc.

2.1.4

Lost my licence
Send an email with the licence number to order@indexbraille.com and Index Braille send you a new file to
your email address free of charge.

2.1.5

Invalid licence
If your licence is not valid the WinBraille will limit the functionality into Free mode.
Invalid licence may be caused by:
· Running to many computers one the same licence key
· Manipulation of the licence file
· If the internet access between WinBraille and Index server is blocked
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Basic features
The pictures below shows main window in source and braille view.
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Menu bar
All features are available through the menu bar. Choosing a menu opens a new window, where you can make
subsequent choices.

2.3.1

Free
WinBraille Free Menus
Menu
File

Function summary
Options to open, save and emboss documents, templates and setup the general presentation.

Edit

Options to move and delete text within a document. The find and replace options are adapted
for screen readers.
Zoom in and out and choose between viewing a translated document in Braille, translated text
or ordinary text.
Insert page brakes and line brakes.
Translate to Braille, option to set up template and to select braille key enty
Provides a searchable help document and upgrades.

View
Insert
Braille
Help

2.3.2

PRO
WinBraille PRO Menus
Menu
File
Edit
View
Insert
Format
Table
Braille
Tools
Window
Help

2.4

Function summary
Options to open, save and emboss documents and templates and setup WinBraille
Options to move and delete text within a document. The find and replace options are adapted
for screen readers.
Zoom in and out and choose between viewing a translated document in Braille, translated text
or ordinary text.
Insert Equation, page brakes, line brakes, lists, table of Contents
Source document: Fonts, attributes, alignment, size, indents etc:
Braille document: Linespacing, Hypernation, alignment, indents etc:
Standard table editor
Translate to Braille, option to set up template and to select braille key entry
Spelling and select dictionary
Select how to present the windows
Provides a searchable help document and upgrades.

Tool bar
The tool bar gives quick access to the most commonly used features, like opening, saving and printing
documents. It provides a view over your structured document. Here is where you see which styles you are
using.

2.5

Status bar
In the bottom of each window you will find specifications about the document you are working on. It gives
you information about your settings and where you are in the document.
From left to right:
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Body text/header/
footer:
Page:
Line:

The text type where your cursor is.

Viewed page (Total number of pages).
The line where your cursor is, starting from number 1 on the top of the first page and
counting up.
Col:
The column where your cursor is. In text view it starts counting from number 1at the
left side to 108 at the right side. For text translated into Braille the column starts at 1
and continues through 34.
Zoom:
Shows the zoom factor in percentage. 100% is normal.
Insert/Overwrite:
Decides what happens when you type. The text you are typing can either move the rest
of the text, insert, or erase it, overwrite.
Character Key Entry/ Specifies whether you use your keyboard with character or Braille key entry.
Braille Key Entry:
Normal:
Text style where your cursor is.
Braille translation: Shows the Braille translation used in the template of the document. Grade 1 Braille in
English will show up as English_g1 and grade 2 as English_g2.
Template:
Name for example Default English Template, My Template
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Getting Started
This chapter provides a step-by-step tutorial to quickly get started, tells you how to open templates and
documents, edit, translate and send your documents to a Braille embosser.

3.1

Program installation

3.1.1

Before starting the installation
To ensure a smooth installation, please:
1. Uninstall old Index Braille program from Start/ Control Panel/ Add or Remove Program. For example:
- WinBraille 4
- Braille Labeler
- Embosser Utility
- ibPrint
2. Delete all old Index Braille printer drivers from Start/ Printers and Faxes
3. Close all programs
4. Ensure that you have Administrator rights before starting the installtion

3.1.2

From internet or Index CD
Download and save the Index Braille Download Manager on your desktop.
Start the Download Manager by double click on the icone. Please follow the Setup Wizard and launch the
Download Manger.
The Download Manager will first seach for latest program versions at Index web site. Without internet
access it will automatically look for the program at Index CD.
Tag the Index programs you would like to install. Remember to always tag the "Index Add Printer Wizard".
This is the printer driver used by all Index programs.
Select "Download" and follow the Setup Wizard for each program.
Add Printer Wizard installation messages
WinBraille installation messages
· Security Warning - select Run
· Accept licence agreement
· Select Menu languages from the list
Template Wizard messages
· Select embosser to be used on this template from the list of installed embossers
· Select page size and orientation
· Select languages
- Braille translation language and grade
- Language of WinBraille Template style names to correspond with style names used by MS Word in
your language.
· Select Braille translation code. The Wizard will suggest the language used by your keyboard.
· Select margins gives the calculated character per line and lines per page
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Add Printer Wizard
Add Printer Wizard installation messages
· Security Warning, press Run
· Security Warning, Unknown Publisher, press Run
· Welcome message, press Next
· Select Destination Location, press Next
· Select Start Menu Folder, select Next
· Select desktop and/or quick launch icon, press Next
· Ready to install, press Install
Connect your Index embosser V3 firmware 12.02 or higher to your PC to start the plug and play hardware
wizard.

3.1.2.1.1 Plug & Play USB
Power on your Index embosser and plug it into your computer.
The Found New Hardware window starts.
Plug & Play installation messages
· Can Windows connect to Windows Update to search for software?
No, not this time (check on Internet)
· Install the software automatically (Recommended)
· If several Index printer drivers are displayed please select:
The Index Braille driver with your product name and the highest version number.
Product names Index Basic-D, Index Everest, Index 4x4 PRO or Index 4Waves PRO.
· Click Finish
Wait while the wizard installs the Index printer driver, this may take a few minutes.
· Windows message: Your new hardware is installed and ready to be used
3.1.2.1.2 Parallel Port setup
Power on your Index embosser and plug it into your computer.
If the "Found New Hardware wizard" do not start up automatically please start it manually by:
Menu / Start / Printers and Faxes/ Printer Task select Add a printer.
The Found New Hardware window starts.
Plug & Play installation messages
· Local or Network printer.
Tag: Local printer attached to this computer
Tag: Automatically detect and install my Plug and Play printer
· Can Windows connect to Windows Update to search for software?
No, not this time (check on Internet)
· Install the software automatically (Recommended)
· If several Index printer drivers are displayed please select:
The Index Braille driver with your product name and the highest version number.
Product names Index Basic-D, Index Everest, Index 4x4 PRO or Index 4Waves PRO.
· Click Finish
Wait while the wizard installs the Index printer driver, this may take a few minutes.
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· Windows message: Your new hardware is installed and ready to be used
3.1.2.1.3 Setting up Index Printer Driver
Setup values after installation
Go to Start /
Printers and Faxes //
Select the Index printer driver (Index Basic-D, Index Everest, Index 4X4 PRO or Index 4Waves PRO)
Go to properties by right clicking on the Index Printer driver
The Index Printer driver has six tabs, General, Sharing, Ports, Advanced, Security and About.
Set Printing Preferences
Select the General tab and press "Printing Preferences..." opens a new window where your preferred printer
setting may be defined. This setting will be default when using this printer driver.
Print
Check box "Include Graphics".
Paper
Duplexing/Folding, Double Sided/Single Sided and check the boxes "Z-folding" and "Saddle" for
embossers with these functions.
Paper and Margin Settings
Set Paper size by selection from the list.
Set Binding Margin from the list.
Define your own paper size, margins etc by opening the "Forms" dialog.
Modifications
Number of Copies, select from the list normally 1.
Multiple impact, select from the list normally 1.
Impact Level, select normal or high
Translation/Rule file
These settings defines the braille translation file when embossing from other applications than WinBraille 5.
Normally the Translation/Rule File is set to your braille language. The Exception list is normally not used,
keep it as it is. For more information read the manual section Exception List.
Banner page
This function generates a banner page in braille and letter graphic with the following information:
· Banner text in Emboss/ Properties / modification window. Accepted characters is a-z, A-Z and 0-9.
· Copies: ##, = Number of ordered copies in the job
· Pages: ## = Number of pages in this document.
About
Version number, copyright etc.
3.1.2.2

WinBraille installation
WinBraille installation messages:
·
·
·
·
·

Welcome window, press Next
Licence Agreement, select "I accept..." and press Next
Information window news in this WinBraille 5 version, press Next
Select Destination Location, press Next
If the Folder Exist window pops up, press Yes
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·
·
·
·
·

3.1.2.3

Select Start Menu Folder, press Next for default
Select additional icon and press Next
Ready to Install, press Install
Select menu language, select from the list or accept the pre selected and press Next
Completing the WinBraille Setup Wizard, press Finish

Template wizard
WinBraille starts this Template Wizard automatically during first insallation
Template Wizard messages
· Welcome, press Next
· Select Embosser from the list, press Next
· Select Braille Page size and orientation, press Next
· Select Braille translation languge from the list. Example english_g2.ibk where english is the language, g2
grad of braille (g0 compuger, g1 literaty and g2 contracted), press Next
- Select Braille translation properties as for example capital prefix.
· Select Template Style language to correspond with the language in your MS Word, press Next
· Select margins, press Next
· Finish window, press Finish to start up WinBraille 5

3.1.3

Adding network embosser
Follw the instructions at www.indexbraille /support /knowledge base/ Network 1, 2, 3, 4 and in the embosser
manual.

3.1.4

Install MS Office Add-ins
Office add-ins for Word and Excel will automatically be installed during the WinBraille installation
process.
If the Add-ins programs are not correctly installed this is indicated by no Emboss button or not correct
function in the File/ Emboss menu in Word and Excel.
In this case the Add-ins has to be separately re-installed by WinBraille, as below:
· File // Options // General and select "Office Add-ins.."
· Press Install
The Uninstall of Office Add-ins is made in the same way by pressing the "Uninstall" button.

3.2

Templates - your braille filter
When translating text into Braille, WinBraille templates are your filter. The templates decide how your
Braille document will be formatted and translated.
It is important to personalize your template to your preferred Braille language, page layout, style information
etc. It will make the translation into Braille more efficient.
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Using templates
When you open a document in WinBraille you must connect it to a template, your Braille translation filter.
When installed WinBraille includes template already set up with the braille translation, page size, margins
etc. that you defined in the Template Wizard during the installation.
To edit templates
To edit any template:
- Find and open - File/ Open/ My Braille Template/ Default English Template etc, press open.
- Edit - Braille/ Braille translation properties/ Select and edit page layout, Translation, headers etc.
- Apply - Press the "Apply To Document" before going to an other tab, make all changes and "Apply To
Document" after each of them.
- Save - Save as Template, by select "My Braille Template" folder, template name and press save.
Templates are normally used as a source document, and are not to be translated to braille.
If your template has accidentally been translated, please delete the text in the translated document. Change to
source view and delete the source text as well. Now overwrite the faulty template with your corrected one
that is in your source view.
Included templates:
In the folder "My Templates":
Default (language)Template (Your braille language, A4/ 12" paper etc.)

3.3

Opening an new document
To open an empty document:
1. Press ctrl+N or open the File menu and choose New.
2. Choose template.
3. Open.

3.4

Editing documents
If you start with a blank document you can just start typing. You can write, erase, cut and paste text within
your document using the Edit-menu. The document layout, such as margins, headings, headers and footers, is
connected to the template and can be changed. Read more in the Personalize templates chapter.

3.4.1

Editing with Braille input
To edit with Braille input:
Change between Braille Key Entry and normal keyboard entry in the Braille menu.

3.4.1.1

Braille key input
Type Braille cells directly on to your standard keyboard by pressing a combination of keys, showed below:
f = dot 1, d = dot 2, s = dot 3, j = dot 4, k = dot 5, l = dot 6
f
d
s

j
k
l
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Translating into braille
To translate your document:
1. Open the document with your preferred template.
2. Go to the Braille menu and choose Translate. Your document will be translated on the screen into the
Braille language. A complex document may take several minutes to translate.

3.6

Embossing
Emboss the translated document.
1. In the File menu, choose Emboss.
2. Select embosser.
3. Select print range; All, Current page or Selection
4. Choose OK.

3.6.1

Printer driver properties
By pressing the Properties button at the Index Printer driver you may also select:
1. Print
- Include Graphics
2. Paper
- duplexing; double sided, single sided, z-folding, saddle stitch format
- Units mm or inch
- Orientation
- Paper and margin settings
3. Modification
- Number of copies
- Multiple impact 1-5
- Impact level normal/high
- Banner page tag with text field, support a-z, A-Z and 0-9.
4. About
- Information about WinBraille 5 etc
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Working with WinBraille
This chapter will help you learn to use the program and experience its functions. All functions and menus are
available in WinBraille PRO. You can view the functions WinBraille Free supports in the section
"WinBraille Overview".

4.1

Navigate smoothly
The "Go to Page" option is designed for the visually impaired. You can use it to browse quickly through
your document. In the Edit menu choose "Go to Page" and select a page number.

4.2

Customizing WinBraille
Let WinBraille have the appearance and functions you want. In this section you'll learn to customize its
layout and functions.

4.2.1

Define user interface
To make general changes:
1. In the file menu, choose Options...
2. Choose General.

4.2.1.1

Option/ general Free and PRO

4.2.1.1.1 Upgrade to PRO
To upgrade from WinBraille Free to PRO:
1. In the file menu, choose Options...
2. Choose General.
3. Select PRO in the drop down menu "WinBraille mode"
4. Go to the Menus tab and press "Check All" which enables all menu options.
5. Save the settings.
WinBraille PRO is free of charge for 60 days. Install the licence key before the trial period is over. If the
installation key has not been installed WinBraille will automatically change to Free mode.
4.2.1.1.2 Handle new documents
By ticking the boxes you can choose to always:
· Create a new document at startup.
· Maximize new documents.
· Translate to braille.
· Zoom factors for text and braille document
4.2.1.1.3 Set menu languages and units
In the drop down menus you can:
· Choose to view units in millimetres or inches.
· Change menu languages.
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4.2.1.1.4 Office Add-ins
In WinBraille select:
· File // Options // General and select "Office Add-ins.."
· Press Install
The Uninstall of Office Add-ins is made in the same way by pressing the "Uninstall" button.
4.2.1.2

Option/ Tempalte Free and PRO
To make general changes:
1. In the file menu, choose Options...
2. Choose General.

4.2.1.2.1 Set default templates
To change default template:
1. Customize a template, following the guide in the section "Personalize templates".
2. Save the template in "My templates" with a new name, for example "My letter template".
3. In the File menu go to Options, choose Template.
4. Go to default template and browse to the "My templates" folder.
5. Select "My letter template" and choose OK.
4.2.1.3

Option/ Software upgrade Free and PRO
WinBraille updates are free of charge. You can upgrade the program by manually checking for updates in
the help menu, or tell WinBraille to check update at startup.
To update WinBraille at startup:
1. In the file menu, choose Options...
2. Choose Software updates.
3. Make sure the box is ticked.
4. Select OK.

4.2.1.4

Option/ Menus PRO only
To choose what menus and submenus to view:
1. In the File-menu go to Options...
2. Choose Menus.
3. By selecting or unselecting the boxes choose which menus to view.

4.2.1.5

Option/ Shortcuts PRO only
In this option you may customize all shortcuts in WinBraille PRO. This may be convenient when other
programs has the same shortcut.
Change the shortcut by double click on the shortcut and press the new shortcut on your keybord and save it.

4.2.1.6

Option/ Paste operation PRO only
When you import a document from Microsoft Word, the most common styles it contains will be converted to
WinBraille styles. To make sure that styles will be converted to WinBraille styles, go to File, Options / Paste
Operation and tag "Convert all pasted styles to WinBraille styles".
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In the View-menu you can choose to view or hide:
· Horizontal ruler
· Vertical ruler
· Status bar
· Tool bar
4.2.2.2

Set zoom factor
As you work on your document, you may want to zoom in or out to get a better view of what you are doing.
You have two choices when setting the zoom factor, change it for your current document or change the
default zoom factor for all documents.
To set the Zoom factor for your current document only, go to Zoom in the View menu and choose Zoom
percentage.
To set the Zoom factor for all documents:
1. In the File menu choose Options.
2. Under the tab General, find Zoom factor.
3. Set the Zoom factor for source and/or Braille document.
4. Press Save.

4.3

Template wizard
Make a new personal template by:
Menu File/ Template Wizard/
Template wizard messages:
· Select embosser from the list of installed embossers
· Select paper size and orientation
· Select margins
· Select braille translation language and template name language.
- Example: English_G2.ibk where English is the language, G2 the grade (G0 computer, G1 Literary and
G2 contracted braille)
- English Styles: Normal, Header 1, Header 2, Header 3 etc.
· - Swedish Style names: Normal, Rubrik 1, Rubrik 2, Rubrik 3 etc.
· Give the template a name
- Include significant information for example Book A4 English
· - Finish

4.4

Make a new personalize templates
Template Wizard
To use the Template Wizard:
· Welcome, press Next.
· Select Embosser from the list, press Next.
· Select Braille Page size and orientation, press Next.
· Select Margins and get calculated characters per line and lines per page.
· Select Braille translation language from the list. Example english_g2.ibk where english is the language, g2
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grad of braille (g0 computer, g1 literaty and g2 contracted), press Next
- Select Braille translation properties as for example capital prefix.
· Select Template Style language to correspond with the language in your MS Word, press Next
· Give Template name and press Next.
Name like: Book A4 English, include the characteristic of your template
· Finish window, press Finish to start up WinBraille 5.
The new template can be found in the File menu/ Open. Choose the icon "My Braille Templates".
Now, start editing your template using Braille Translation Properties in the Braille menu. You may select the
new template as your default template in Menu File/ Options/ Templates. Browse for your new template and
save it as default.

4.4.1

Setting up your template
Before you get into the deeper levels of designing your personal template, you should make sure to specify
its general size, shape and translation. Doing this first will ensure consistency throughout all your
documents. Before you start working on a new document, open a template and take care of these tasks.

4.4.1.1

Page layout Free and PRO

4.4.1.1.1 Setting paper size and orientation
Consider the paper size and orientation that will be used for the finished documents. For example if you are
using A4 paper on single sheet Index Embosser choose A4.
Open your template, for example "My Letter Template" and change the page layout
1. In the Braille menu, choose Braille Translation properties.
2. In each tab you are about to view, all changes are saved when choosing Apply.
3. Page layout: choose page size.
4. Orientation: choose between portrait and landscape format.
5. A Preview page will show your changes.
6. Choose Apply to save the changes.
7. Close the window
4.4.1.1.1.1 Add new paper size
How it works
A new paper size may be created in the Index printer driver (Index Everest). When this custom defined
paper size is created you select it in the template you are using.
Steps to add new paper size
1. Start Program/ Printers and Faxes/
2. Select your Index printer driver icon, example Index Everest
3. Right click on it and select "Printing Preferences..."
- Select the Paper tab
- Press on the Form button, open the add new paper form
-- Type New Form Name in this field
-- Define paper size width and Height in cm, 1 inch = 2.54 cm
-- Define print area margins. This defines the areas outside of the area which can be embossed.
Example, if the new paper -- width is below 248,5 mm these margins is normally set to 0 for
Everest and Basic-D and 4Waves PRO.
-- Save Form and close
- Close the "Printing preferences..." by pressing OK
Select your new page size
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Select it by opening you Template go to Braille/ Braille Translation Properties/ Page Layout and select your
new page form from the drop down list as normal.
4.4.1.1.2 Setting margins
To set margins:
1. In the Braille menu choose Braille Translation Properties.
2. Select Page Layout.
3. Select binding, outer, top and bottom margins.
4. In two windows below you can view how your changes will affect the number of characters per line and
lines per page.
5. Select Apply to document.
6. Close the window
4.4.1.2

Change braille translation
In the translation option you can choose which Braille translation to use. WinBraille includes more then 80
translations languages and both contracted and uncontracted Braille.
Rule file name and corresponding braille translation
· Sample: english_g2 :
English is the braille translation language
· g2 is the grade where g0 is computer, g1 is literary and g2 contracted braille.
· If there is several versions of a language these are defined with v1, v2 etc.
To change Braille translation:
1. In the menu Braille choose Braille Translation Properties.
2. Select all styles in the left hand menu.
3. Choose Braille Translation file in the drop down menu.
4. Choose Apply to Selected Styles.
5. Close the window.

4.4.1.2.1 Exception List PRO
When translating into contracted Braille with abbreviations you can tell WinBraille to make exceptions. For
example names, street addresses and cities can be misunderstood when translated with contracted Braille.
To set exceptions:
1. Close all windows and open the template you want to modify.
2. In the Braille menu choose Braille Translation Properties.
3. Make sure the box "Advanced" is selected.
4. Go to Translation.
5. Choose Exception file. Generic exceptions is the default file.
6. Choose Edit.
7. In a pop up window you can type in your exceptions.
8. After each word, select Add. You may also remove exceptions.
9. When you are finished, select OK
10.Apply to Selected Styles
11. Close the Window
4.4.1.3

Setting header/footer
If your WinBraille document requires page numbering, date or file name, set up these following the
instructions below.
To create header or footer:
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1.
2.
3.
4.
5.
6.
7.
8.
9.

4.4.1.4

In the Braille menu go to Braille translation properties.
Choose Header/Footer.
Tick the box "Use Header/Footer".
Type your own header/footer or select the plus. It gives you standard information such as Braille page
number, source page number file name etc.
Style: Option for changing text format. "Normal" is recommended.
Position: 0 lines puts the header/footer close to the paper edge. 1 line pushes it down/up one line.
You can select separate headers/footers on the first page and on even pages by ticking the boxes and
following step 1-4.
Apply to document.
Close the window.

Paragraph
1. Close all windows and open the template you want to modify.
2. In the menu Braille Translation Properties, choose Paragraph.
3. Select the style you would like to change or all styles if you would all styles to be handled in the same
way. You can now select:
- Indents for the first line, left and right indents.
- Space between paragraphs.
- Text alignment, left, centred or right.
4. Press "Apply to Selected Styles".
5. Repeat step 3 to 4 for styles handled differently
6. Close the window and save your template
Widow/Orphan Control
This control is ON as default with all styles, as in MS Word.
Definitions:
A widow is the last line of a paragraph printed by itself at the top of a page.
An orphan is the first line of a paragraph printed by itself at the bottom of a page.
The Widow/Orphan Control tryes to, if possible print the text on the first page. If not, it will split the text on
the page brake or move it to next page depending on the text block size.
Clip lines with equal charactes to page width
If you emboss a text document with for example a ****** line across the page width, WinBraille will clip it
to one braille line when "Clip lines..." box is checked.
Start paragraph on new page
To start paragraphs on a new page:
1. In the Braille menu choose Braille Translation Properties.
2. Go to Paragraph.
3. Check the box "Start paragraph on new page".

4.4.1.4.1 Paragraph advanced PRO only
To make more advanced paragraph settings, check the advanced button in the Braille Translation Properties
footer.
Start paragraph on new page if....:
In advanced mode "Start paragraph on new page" has the additional function to move the textblock to the
next page only if remaining text is less than a defined number of lines, 1-5 lines.
Compact text:
Tabs can be replaced with your defined number of spaces.
Join paragraphs:
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Choose to merge the paragraphs in your source document.
Separator line:
A Separator line is a line across the page placed before or after a specified style. You can choose separator
line, text and position.
4.4.1.5

Document options PRO only

4.4.1.5.1 Setting line spacing
To set line spacing:
1. Close all windows and open the template you want to modify.
2. In the menu Braille Translation Properties choose Document Options.
3. Choose line spacing in percentage, 50-250%.
4. Select Apply to Document.
5. Close the window
4.4.1.5.2 Setting math tranlation
To set line spacing:
1. Close all windows and open the template you want to modify.
2. In the menu Braille Translation Properties choose Document Options.
3. Choose Math braille translation file from the list. Available September 2008.
-math-nemeth
-math-swedish
-math-latex
4. Select Apply to Document.
5. Close the window
Mathematics expression made be Equation Editor will be translated into braille math following the selected
rules.
4.4.1.5.3 Setting hyphenation
When you translate into Braille, each line will have fewer words compared to your source document. You
may want to select how to split words that carry over a line before translating your document.
To set hyphenation:
1. Close all windows and open the template you want to modify.
2. In the Braille menu choose Braille Translation Properties.
3. Choose "split words longer than #" in drop down menu. Where # is 4 to 9 characters.
4. Select Apply to Document.
5. Close the window
4.4.1.5.4 Bullet list
Select bullet character, indent and space between the bullet and paragraph.
4.4.1.5.5 Table translation
Select between stairstep, rotated and as in source from the drop down list.
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Advanced braille settings
WinBraille is equipped to make the translation into Braille as smooth as possible. For example, a Braille
document is normally longer then the text document it originated from and each line on the paper fits fewer
characters. This section goes through some of WinBraille's special Braille features. All changes are made in
the template, and will affect all document you choose to open with this template.

4.4.1.6.1 Modifying braille translation properties in a document
To ensure that the same type of documents are translated in the same way, we recommend that you make all
changes in your template document. However it is possible to make the same structure of changes in your
translated document.
To the braille translation properties in a document and translate it
· In the View menu choose to view the source document.
· Go to Braille/ Braille translation properties and tag "Advanced". The the buttons "Apply to Current
Paragraph" and "Apply to Selected Styles" will appear.
- Select "Apply to Current Paragraph" if you would like the changes to effect all styled marked with this
paragraph form example "Normal".
- Select "Apply to Selected Styles" if you would like the changes to effect only can use all functions in a
similar way as when using a Template, but the changes will only effect the selected part of the document.
- First mark the text than, press "Apply to selected text" if you would like the selection to only effect the
selected text. This function is typically used in dictionaries where each column should be translated to a
specific language. See examples and ideas, Dictionary.
· Translate your document again following the modified braille translation properties for this specific
document.
4.4.1.7

Working with styles
Using styles consistently throughout your document will make it easier to read and overlook. In Braille
documents, you can use styles to distinguish, for example, all top level headings. Applying consistent styles
is also important if you're creating a table of contents.
WinBraille includes a variety of styles that are suited for Braille documents. The style names, such as
"Heading 1", "Heading 2" and "Normal" suggests where the style should be used.

4.4.1.7.1 Applying styles
The easiest way to apply styles is to use the drop down menu in the toolbar. The style will be set to normal
before you have applied any styles.
To apply a style to a paragraph:
· Select the paragraph or paragraphs you want to change. Then do one of the following:
· Click the drop down menu "Normal" in the toolbar and choose the style you want to apply.
· In the menu Format, go to Edit format. Select the style you want to apply and click "Apply to selected
text."
4.4.1.7.2 Modifying styles
If you don’t find a paragraph style that look exactly how you want it, you can modify an existing style. You
may for example want to add an extra line under a top level header or put an indent in the first line of the
body text.
You can change your styles in your template to use them for more then one document.
To modify styles in your template:

Index Braille, Sweden 2008-10-15 www.indexbraille.com

Working with WinBraille

21

1.
2.
3.
4.

Close all open WinBraille documents and open a new document with your preferred template.
In the menu Braille choose Braille Translation Properties.
Choose Paragraph.
Select the style you wish to modify. When you change the style you can view the changes in a square on
the right hand side of the window.
5. Select Apply to Selected Styles.
6. Save the template.
4.4.1.7.3 Adding new styles
When using multiple languages adding new styles is convenient. For example you can add a style for your
second language.
To add a new style:
1. In the Braille menu choose Braille Translation Properties.
2. Choose Translation.
3. Below the Style window, select the plus.
4. A pop up window called "Add style" will show up.
5. Select Normal style to base the new style on.
6. Type in a name for your style, for example "Normal French", and select OK.
7. Select your style and choose rule file.
8. Select "Apply to selected styles".
9. Close the window.
4.4.1.7.4 Importing styles from other documents
WinBraille and style infomation
WinBraille maintain all style information such as Header 1, Header 2 etc from a source document made in
for example MS Word. Standard styles as Header 1,2.. Normal will be converted to the same WinBraille
styles. All styles which is not defined in WinBraille/ Braille/ Braille translation properties style list will be
treated as "Normal" with the original style name added to the list of styles. The list of styles can be viewed,
edit etc in for example Braille/ Braille Translation Properties../ Translation and Paragraph.
When WinBraille open a document with many styles, these styles will remain with the same style name and
formatting for each individual style. This is a great help when opening a well structured document and
translate it to braille. The only requirement is that all the connected style sheet has correct "Braille
Translation Properties".
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Examples and ideas
This chapter includes examples of many of the things you can do with WinBraille. The examples will help
you create templates for different documents.

5.1

Letter
This guide will go through how to personalize a basic template that can be used for many of your documents.
This letter guide includes:
· Page layout.
· Braille translation

5.1.1

Setting up letter template
Follow the steps to make a personalized Template letter and save as default.
1. Open "My Template". Save the template as "My Letter Template" and edit it.
2. Choose Page layout:
In the Braille menu, under Braille translation properties, choose page layout.
· Select A4, Portrait
· Left margin 3
· Right margin 1
· Top margin 1
· Bottom margin 1
· Apply to Document
3. Set translation:
In the Braille menu, select Translation.
· Select all styles.
· Under "Braille translation file", choose English_g1 or your preferred language file. Apply to document.
Save your "My Letter Template" in File/ Save as template menu.
4. Set "My Letter Template" as WinBraille default template.
· In the File menu choose Options.
· Go to the tab Templates.
· Browse for "My Letter Template" and set as default.

5.1.2

Braille and ink
It is easy to print with braille and ink on the same page when using Everest.
First print the text on your braille paper using your normal laser printer.
1. Select View / Braille document (text wiew) with your Letter document still open
2. Load you laser printer with braille paper.
3. Go to File/ Print, and complete the printing
4. Move the stack of printed papers to the Everest
5. Go to File/ Emboss and complete the embossing
6. Your Braille and Print document is now ready
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Book
This section will show you how to create a template for a book. You can use it to emboss this WinBraille 5
manual.
This book guide includes:
· Header with page number
· Table of contents
· Tables
· Bullet lists

5.2.1

Setting up book template
Start by opening "My Template". Choose your preferred language and page layout and save it as "My Book
Template".
The first part of this book guide will take you through the necessary steps when setting up a Book template.
When you are setting up a template from scratch, first consider what kind of information the text document
contains. With this in mind, set up the translation.

5.2.1.1

Setting headers
Books and long documents like this manual are easier to read with page numbering.
To add Braille page numbering and name of the book in a header:
1. In the Edit menu choose Braille Translation Properties tag "Use header"
2. Type in the "name of the book "
3. Click the plus sign and choose "Braille page number" from the list.
4. Select "Apply to Document".

5.2.1.2

Setting hypernation
This book is long therefore we prefer to have this manual hypernated to reduce the size.
To set Hypernation:
1. In the Braille menu choose Braille Translation Properties.
2. Select Document options
3. In the Hypernation list select "Split words longer than 4".
4. Select Apply to Document.

5.2.1.3

Setting bulleted lists
This manual contains bulleted and numbered lists.
To set translation for lists:
1. In the Braille menu choose Braille Translation Properties.
2. Select translation for bulleted lists. You can exchange bullet characters, indent and spaces.
3. Select Apply to Document.

5.2.1.4

Setting tables
This book contains tables.
To set table translation:
1. In the Braille menu choose Braille Translation Properties.
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2. Choose Document Options.
3. Set table translation. You may choose between translating the table like in the source document, rotated or
stair stepped. Choose "stair step".
4. Select Apply to Document.

5.2.2

Translating book template
When you have made all translation settings your document needs, save the template and open the manual
WinBraille 5.rtf using "Manual Template".
Translate the manual by typing Ctrl+T or choosing Translate in the Braille menu.

5.2.3

Insert table of contents
The translated manual contains styles and you can now generate a table of contents.
To generate a table of contents:
· Place the cursor where you want the table of contents. We recommend to put it on the first page.
· In the Insert menu choose "Table of Contents".
The table of contents will be created where your cursor is. If you want to move your table of contents, you
can cut and paste or simply change its position by clicking return or delete above it.

5.2.4

Emboss
To emboss, first translate the document.
1. In the File menu, choose Emboss.
2. Select embosser.
3. Choose OK.
To make advanced settings, for example change the impact level and set multiple impact, see the chapter
"Advanced embossing settings".

5.3

Dictionary
This dictionary guide will show you how to make an English - French word list.
This guide includes:
· Multiple Braille translations
· Adding new styles
· Tables

5.3.1

Setting up dictionary template
Start by opening a template and saving it as "My English French Template". In the Braille menu choose
Braille Translation Properties.
· Choose page layout.
· Select Braille translation file "English_g1".
· Choose table translation "As in source".
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Setting additional language
To set French as your additional language:
1.
2.
3.
4.
5.

In the Braille menu choose Braille Translation Properties.
Choose Translation.
Below the Style window, select the plus.
A pop up window called "Add style" will show up.
Base your new style on"Normal" and call it "Normal French". Your new style will show up in the window
next to the other styles.
6. Select "Normal French" and choose "French_g1" as your rule file.
7. Select "Apply to selected styles".
8. Save and close your template.

5.3.2

Setting word list
Your template is ready. Now you can start editing your word list.
1.
2.
3.
4.
5.

Open a new empty document using "My English French Template".
Paste the table "English French dictionary" from Word.
In the Braille menu choose Braille translation Properties. Select the "Advanced" button.
Select the column with French words.
Choose the style "Normal French" and "Apply to Current Paragraph".

You can now translate and emboss your word list.

5.4

Braille & print together
Expanding possibilities for Braille & Print
Putting printed text and braille on the same paper has become easier. In the past you needed expensive
embossers. Now, all you need is the software WinBraille 5, an Everest or 4X4 PRO embosser and a standard
laser printer.
Everest supports single and double sided Braille & Print and 4X4 PRO supports four stich format.
To create a Braille & Print document
1. Print on your laser printer
Open and translate the document to text in WinBraille
Send the file to your laser printer by File/ Print/ command.
2. Place the printed stack of paper in Everest/4X4 PRO
It is important to place the pages in correct orientation.
3. Emboss the same document
Go go file/ Emboss. The braille correspondent with the ink printout will now be embossed on top of the text
characters.
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Mathematics
In this section you will learn how to translate and emboss mathematics in WinBraille.
This guide includes:
· Setting template for Mathematics
· Using the Equation Editor

5.5.1

Setting up maths template
To set up a template for documents containing mathematics:
1. Open a template and save as "My Maths Template".
2. In the Braille menu choose "Document Options".
3. Set Math translation file to "math-nemeth".
4. Apply to Document and close the window.

5.5.1.1

The equation editor
If you want to add mathematics to a document you have opened in WinBraille, use the equation editor. It is
in the Insert menu under Equation. The user manual for the equation editor can be found in the Help menu of
the program.
Note: If you don't see any equation icons in the Equation Editor select the toolbar in the View menu.

5.5.2

Translating maths document
Index Braille has prepared a test page in Word with samples of some of the mathematics WinBraille can
translate.
To emboss the sample:
1. Open the Word document "Maths samples" with "My Math Template".
2. Translate and emboss the document.

5.6

Duxbury
Read this section to learn how to emboss Duxbury files with WinBraille.
To Open and emboss a sample Duxbury *.dxb file:
1. Open the file Duxbury sample.dxb with the template "Duxbury.wbrt.", that is included in the WinBraille
installation.
2. Emboss.

5.7

Emboss button MS Word
Direct Emboss button
The emboss button in MS Word top menu is used to emboss a copy of your current Word document in
braille. Your text will be translated into braille following the definition in your Default template and
embossed on your latest used embosser.
The Emboss button is added during the standard installation process. It may be removed or added from
WinBraille menu File/Options/General press Office Add-ins.
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Emboss from file/ Emboss in MS Word
Emboss from file menu in Office 2003
Select File/ WinBraille/ Emboss
Emboss from file menu in Office 2003
Select WinBraille/ Emboss in the Add-ins menu
Selections in WinBraille/Emboss
Embosser: Select Index embosser from the drop down menu
Template: Select Template from the drop down menu. Templates stored in //My Braille Template will be
presented.
Set Automation level: Emboss at once/ Edit braille / Edit text
Range: Document, Selection, Current Page
Number of copies: ##
In addition there is an "Print to file" tagging which may be used for de-bugging purpose etc.

5.9

Emboss from Excel
Emboss from file menu in Office 2003
Select File/ WinBraille/ Emboss
Emboss from file menu in Office 2003
Select WinBraille/ Emboss in the Add-ins menu
Selections in WinBraille/Emboss
Embosser: Select Index embosser from the drop down menu
Template: Select Template from the drop down menu. Templates stored in //My Braille Template will be
presented.
Set Automation level: Emboss at once/ Edit braille / Edit text
Range: Document, Selection, Current Page
Number of copies: ##
In addition there is an "Print to file" tagging which may be used for de-bugging purpose etc.
Direct Emboss button
The emboss button will emboss a copy of the current Word document, translated to braille following the
definition in your Default template and to the latest used embossers in the File/WinBraille Emboss function.
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